
DSP First, 2e Signal Processing First

Lab S-6: FIR Filter Design GUI

Pre-Lab: Read the Pre-Lab and do all the exercises in the Pre-Lab section prior to attending lab.

Verification: The Exercise section of each lab should be completed during your assigned Lab time and
the steps marked Instructor Verification signed off during the lab time. When you have completed a step
that requires verification, demonstrate the result to your instructor and answer any questions about it. Turn
in the completed verification sheet before you leave the lab.

Lab Homework Questions: The Lab-Homework Sheet has a few lab related questions that can be answered
at your own pace. The completed Lab-HW sheet is due at the beginning of the next lab.

1 Pre-Lab

1.1 Objective

The goal of this lab is to learn some methods for designing practical FIR filters in MATLAB. These filters
will have a finite number of coefficients, and a frequency response that approximates an ideal frequency
response shape.

1. Windowing: The concept of windowing is widely used in DSP when dealing with finite-length signals.

2. Filter Specs: The quality of a designed filter is measured by how closely the actual response matches
the desired ideal response. Often the desired match is set prior to the actual filter design step by
drawing a tolerance region around the ideal filter shape. Then the minimum-order filter that fits inside
the tolerance region is designed.

3. Design Methods: Two very common approaches to FIR filter design are windowing and computer
optimization. The filterdesign GUI in the SP-First (or DSP-First) Toolbox can do both.

1.2 Overview

There are many ways to approximate an ideal frequency response with a practical filter. For FIR filters the
frequency response H.ej O!/ is a function of O! that summarizes a LTI system’s response to inputs such as
complex exponentials and sinusoids. The MATLAB function freqz.m is used to compute samples of the
frequency response in the frequency domain.1 A filter design method produces filter coefficients fbkg for
the time-domain implementation of the FIR filter as a difference equation

yŒn�D b0xŒn�Cb1xŒn�1�Cb2xŒn�2�C :::CbMxŒn�M�

so the freqz function is an essential step for making plots of the magnitude and phase of the designed
frequency response and assessing how closely it matches the desired ideal response.

1If you do not have the function freqz.m, there is a substitute available called freekz.m in the SP-First (or DSP-First) Toolbox.
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1.3 Frequency Response of FIR Filters

The general form of the frequency response for an M -th order FIR linear time-invariant system with filter
coefficients fbkg is

H.ej O!/D

MX
kD0

bke
�j O!k

D

MX
kD0

hŒk�e�j O!k (1)

In addition, recall that the impulse response hŒn� for the FIR filter has values equal to the filter coefficients.

1.3.1 MATLAB Function for Frequency Response

MATLAB has a built-in function for computing the frequency response of a discrete-time LTI system. The
following MATLAB statements show how to use freqz to compute and plot both the magnitude (absolute
value) and the phase of the frequency response of an FIR filter whose impulse response is a truncated sinc
function. The plots2 are a function of O! in the range �� � O! � � :

M = 22; %-- Filter Order is even
nn = 0:M; %-- "n index" vector
nsh = n - M/2; %-- put main lobe in center of h[n]
wb = 0.32*pi; %-- "Bandwidth" parameter of sinc
bb = sin(wb*nsh)./(pi*nsh); %-- Filter Coefficients
bb(find(nsh==0)) = wb/pi; %-- fix the divide by zero
ww = -pi:(pi/500):pi; %-- omega hat frequency vector
H = freqz(bb, 1, ww); %<--freekz(bb,1,ww) is an alternative
subplot(2,1,1);
plot(ww, abs(H)), grid on
subplot(2,1,2);
plot(ww, angle(H)), grid on
xlabel(’Normalized Radian Frequency’)

For FIR filters, the second argument of freqz( , 1, ) must always be equal to 1. The frequency vector
ww should cover an interval of length 2� for O!, and its spacing must be fine enough to give a smooth curve
for H.ej O!/. The MATLAB variable for frequency response is capital H to be consistent with H.ej O!/.
Note: The filter coefficients fbkg are indexed from k D 0 to k DM in (1), but since MATLAB’s vector
indexing starts at one, bb(1)D b0.

1.4 Windowing

The concept of windowing is widely used in signal processing. The basic idea is to extract a finite section
of a very long signal xŒn� via multiplication wŒn�xŒn�. This approach works if the window function wŒn�
is zero outside of an interval. For example, consider the simplest window function which is the L-point
rectangular window defined as

wr Œn�D

(
1 0� n� L�1

0 elsewhere
(2)

The important idea is that the product wr Œn�xŒnCn0� will extract L values from the signal xŒn� starting
at nD n0. Thus the following are equivalent

wr Œn�xŒnCn0�D

8̂̂<̂
:̂
0 n < 0

�
��

1

wr Œn�xŒnCn0� 0� n� L�1

0 n� L

(3)

2If the output of the freqz function is not assigned, then plots are generated automatically; however, the magnitude is given in
decibels which is a logarithmic scale. For linear magnitude plots a separate call to plot is necessary.
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The name window comes from the idea that we can only “see” L values of the signal xŒnCn0� within the
window interval when we “look” through the window. Multiplying by wŒn� is looking through the window.
When we change n0, the signal shifts, and we see a different length-L section of the signal.

The nonzero values of the window function do not have to be all ones, but they should be positive. For
example, the L-point Hamming window is defined as

wmŒn�D

(
0:54�0:46cos.2�n=.L�1// 0� n� L�1

0 elsewhere
(4)

The MATLAB function hamming(L) will generate a vector with values given by (4). A stem plot of the
Hamming window would show that the values are larger in the middle and taper off near the ends.

(a) Make a stem plot of the Hamming window for LD 23, over the index range 0� n� L�1.

(b) Determine the maximum value of the window and the index location of the maximum. Also, deter-
mine the values of the window at nD 0, nD 11, and nD 22.

(c) The Hamming window is said to have even symmetry. What does this mean?

1.5 Ideal Filters and Practical Filters

Ideal Filters are given by their frequency response, consisting of perfect passbands and stopbands. The
ideal filters cannot be FIR filters because there is no finite set of filter coefficients whose DTFT will be the
ideal frequency response. The impulse response of the ideal LPF is an infinitely long sinc function as shown
by the following DTFT pair:

hi Œn�D
sin. O!cn/

�n
() Hi .e

j O!/D

(
1 j O!j � O!c

0 O!c < j O!j � �
(5)

where O!c is the cutoff frequency of the ideal LPF, which separates the passband from the stopband.
In the dltidemo GUI, you can choose ideal lowpass filters (LPF), highpass filters (HPF) and bandpass filters
(BPF) because the GUI does not use the impulse response. The ideal LPFs and HPFs have one parameter
for the cutoff frequency. The ideal BPF has a parameter for center frequency which determines where the
band is located; its bandwidth (in the dltidemo GUI) is always 0:4� . All the ideal filters have an additional
parameter for the slope of the phase of H.ej O!/.

Practical Filters are causal length-L FIR filters whose filter coefficients are chosen so that the resulting
frequency response will closely approximate the desired frequency response of an ideal filter. The process
of choosing the filter coefficients is called filter design. The practical FIR filters shown in dltidemo were
designed using MATLAB’s fir1 function for digital filter design. The GUI offers length-15 LPFs and HPFs,
and length-21 BPFs. The LPF and HPF designs depend on specifying one parameter for the cutoff frequency
which lies midway between the non-ideal passband and stopband. The BPF requires two parameters: one for
center frequency which determines where the passband is located, and other for the width of the passband.
In the dltidemo GUI, the default BPF cutoffs are ˙0:2� from the center frequency, so only the center
frequency can be changed. These practical filters do not match ideal filters exactly, and this is readily
apparent at the cutoff frequencies where the frequency response has a magnitude of 0.5.

1.5.1 Truncate the Ideal Impulse Response

One simple approach to designing a practical FIR filter is to truncate the impulse response of an ideal filter.
This can be accomplished with a window function, so we usually say that the practical FIR filter has an
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impulse response that is a windowed version of the ideal impulse response. For example, we could make a
length-23 FIR lowpass filter by taking the center portion of the sinc function:

h1Œn�D wr Œn�hIDEALŒn�11�D

8<:
sin. O!c.n�11//

�.n�11/
0� n� 22

0 elsewhere
(6)

where wr Œn� is a 23-point rectangular window. The sinc function must be time-shifted to put its peak in
the middle of the window at nD 11, because we want the system defined by h1Œn� in (6) to be causal. It is
common that the ideal impulse response is time shifted by an amount equal to half the window length.

(a) For the time-windowed sinc function in (6), set !c D 0:7� . Then make a stem plot of the impulse
response h2Œn�.

(b) Use MATLAB to determine (samples of) the DTFT of h2Œn� and make a plot of the DTFT magnitude,
jH2.e

j O!/j.

(c) We could experiment with different window functions. Change the window to the 23-point Hamming
window, and define a new impulse response as

h3Œn�D wmŒn�

�
sin. O!c.n�11//

�.n�11/

�
Plot the impulse response.

(d) Use MATLAB to determine (samples of) the DTFT of h3Œn� and make a plot of the DTFT magnitude,
jH3.e

j O!/j. Explain why this “practical filter” is a better LPF than H2.e
j O!/ when evaluated as an

approximation to the ideal LPF.

1.6 GUI for Filter Design

The interactive MATLAB GUI called filterdesign illustrates several filter design methods for LPF,
BPF and HPF filter. The interface is shown in Fig. 1. Both FIR and IIR filters can be designed, but we will
only be interested in the FIR case which would be selected with FIR button in the upper right. The default
design method is the Window Method using a Hamming window. The window type can be selected from
the drop-down list in the lower right. To specify the design it is necessary to set the order of the FIR filter
and choose one or more cutoff frequencies; these parameters can be entered in the edit boxes.

The plot initially shows the frequency response magnitude on a linear scale, with a frequency axis in
Hz. Clicking on the word Magnitude will toggle the magnitude scale to a log scale in dB. Clicking on the
word Frequency will toggle the frequency axis to normalized frequency O!, and also let you enter the cutoff
frequency using O!. Recall that O! D 2�.fco=fs/. The plotting region can also show the phase response of
H.ej O!/, or the impulse response of the filter hŒn�. Right click on the plot region to get a menu.

The filter coefficients can be “exported” from the GUI by using the menu File->Export Coeffs. To
have some filters for comparison, redo the designs from the Section 1.5.1, and export the filter coefficients
to the workspace under unique names. Then you can make your own plot of the frequency response in
MATLAB using the freekz function (or freqz) followed by a plot command.

The Options menu provides zooming and a grid via Options->Zoom and Options->Grid.

1.7 Design Filters with the filterdesign GUI

For practice, use the filterdesign GUI to design two lowpass FIR filters with orderM D 22 (or length
LD 23). Use a cutoff frequency of O!c D 0:32� D 2�.1600=10000/. Create one using a Hamming window,
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Figure 1: Interface for the filterdesign GUI. When the Filter Choice is set to FIR, many different win-
dow types can be selected, including the Hamming window and the Rectangular window (i.e., no window).
The specification of one or more cutoff frequencies .fco/ must be entered using continuous-time frequency
(in Hz), along with a sampling rate (fs , also in Hz). In normalized frequency, the cutoff frequency is
O!co D 2�.fco=fs/.

the other with a Rectangular window which should give a result like Fig. 2. Right click on the plot to see
options for displaying the impulse response either windowed or unwindowed. The unwindowed version just
displays the truncated sinc function, i.e., rectangular windowing.

1.7.1 Passband Defined for the Frequency Response

Frequency-selective digital filters, e.g., LPFs, BPFs and HPFs, have a frequency response magnitude that
is close to one in some frequency regions, and close to zero in others. For example, the plot in Fig. 2 is a
lowpass filter whose magnitude is close to one when 0 � O! < 0:883: This region where the magnitude is
close to one is called the passband of the filter. It will be useful to have a precise definition of the passband
edges, so that the passband width can be measured and we can compare different filters.

(a) From the plot of the magnitude response, e.g, in MATLAB or in the filterdesign GUI, it is
possible to determine the set of frequencies where the magnitude is very close to one, as defined byˇ̌̌
jH.ej O!/j�1

ˇ̌̌
being less than ıp. This deviation from one is called the passband ripple. A common

choice for the passband ripple is between 0.01 and 0.1, i.e., 1% to 10%. The set of frequencies in a
passband should be a region of the form O!1 � O! � O!2.

(b) For a lowpass filter, the passband region extends from O! D 0 to O!p, where the parameter O!p is called
the passband edge. For the two LPFs designed in Section 1.7 determine an accurate estimate of
O!p assuming a passband ripple (ıp) of 0.1 for the Rectangular window case, and ıp D 0:01 for the
Hamming window case.3 Compare these actual passband edges to the design parameter O!c which is
called the cutoff frequency.
Note: There is often confusion that O!c and O!p are the same, but after doing a few examples it should
become clear that is not the case.

3The filterdesign GUI has a zoom capability (Options->zoom), and the grid can be turned on (Options->grid). Also,
when the pointer is placed to hover over the frequency response the coordinates are read from the plot.
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Figure 2: Passband and stopband defined for a typical lowpass filter. This particular filter is a length-23
FIR filter designed with a rectangular window and a sinc function with a cutoff frequency of O!c D 0:32� .
The passband and stopband ripples are defined to be 0.1, from which the passband and stopband edges can
be measured. The approximate value of the passband edge is O!p D 0:281� � 0:883; the stopband edge,
O!s D 0:358� � 1:125.

1.7.2 Stopband Defined for the Frequency Response

When the frequency response (magnitude) of the digital filter is close to zero, we have the stopband region
of the filter. In the lowpass filter example of Fig. 2, the magnitude is close to zero when the frequency
1:125� O! � � , i.e., high frequencies. When the frequency response of a LPF is plotted only for nonnegative
frequencies, the stopband will be a region of the form O!s � O! � � . The parameter O!s is called the stopband
edge. We can make a precise measurement of the stopband edge as follows:

(a) For the lowpass filters from Section 1.7, zoom in on the plot of frequency response magnitude in the
filterdesign GUI to measure the stopband edge, or use a dB magnitude plot. Then determine the
set of frequencies where the magnitude is nearly zero, as defined by jH.ej O!/j being less than ıs D 0:1
for the Rectangular window case, and less than ıs D 0:01 for the Hamming window design.

(b) Compare the values of O!s found in the previous part to the design parameter O!c (the cutoff frequency).

1.7.3 Transition Zone of the LPF

The difference between the stopband edge and the passband edge is called the transition width of the filter:
� O! D O!s � O!p. The smaller the transition width, the better the filter because it is closer to the ideal filter
which has a transition width of zero.

(a) For the two lowpass filters from Section 1.7, determine the transition width.
Note: Comment on the statement, “when comparing equal-order FIR filters, the one with smaller
transition width will have larger ripples.”

(b) Design two new LPFs that have the same cutoff frequency, O!c D 0:32� , but twice the order, i.e.,
M D 44. Repeat the measurement of O!p, O!s and � O! for these two LPFs.

(c) Compare to the values of � O! from part (a). When the order doubles, describe what happens to the
transition width.
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1.7.4 Summary of Filter Specifications

The foregoing discussion of ripples, bandedges, and transition width can be summarized with the tolerance
scheme shown in Fig. 3. The filter design process is to approximate the ideal frequency response very
closely. Once we specify the desired ripples and bandedges, we can draw a template around the ideal
frequency response. An acceptable filter design would be an FIR filter whose magnitude response lies
entirely within the template. The length-23 FIR filter shown in Fig. 3 meets the specs, but if you designed a
length-19 filter it would have a transition width that is greater than � O! D 0:08� .
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Figure 3: Tolerance scheme drawn around an ideal LPF with a cutoff frequency of O!c D 0:32� . Dashed lines
indicate the maximum allowable deviation from the ideal LPF. The template uses O!p D 0:28� , O!s D 0:36� ,
and ıp D ıs D 0:1. The actual FIR filter shown is the length-23 FIR filter from Fig. 2 which just barely
meets these specs.
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2 Lab Exercise

The objective of the lab exercise is to design FIR filters that can be lowpass, highpass or bandpass filters.
The exercises will involve using the GUI filterdesign in which FIR filters are designed via the window
method, or with a computer optimization technique.

2.1 Design Two Lowpass Filters

Design two lowpass FIR filters with M D 30 and O!c D 0:4� D 2�.2000=10000/, one using a Hamming
window, the other with a Rectangular window. For the measurement of passband and stopband edges, there
are two approaches: use the filterdesign GUI and read numbers from the plot, zooming when necessary,
or export the filter coefficients from the GUI and use MATLAB to make plots of the magnitude of the
frequency response using freekz (or freqz) and plot. In MATLAB zooming would be more precise and
reliable because the frequency sampling can be specified in the call to freekz.

(a) For the filter obtained with the rectangular window, determine an accurate measurement of the pass-
band edge . O!p/ assuming the passband ripple specification is ıp D 0:1, i.e., 1˙0:1.

(b) For the filter obtained with the rectangular window, determine an accurate measurement of the stop-
band edge . O!s/ assuming the stopband ripple specification is ıs D 0:1.

(c) For the filter obtained with the Hamming window, determine an accurate measurement of the pass-
band edge . O!p/ assuming the passband ripple specification is ıp D 0:01, i.e., 1˙0:01.

(d) For the filter obtained with the Hamming window, determine an accurate measurement of the stopband
edge . O!s/ assuming the stopband ripple specification is ıs D 0:01.

(e) Question: is the cutoff frequency half way between . O!p/ and . O!s/ for both filters?

Instructor Verification (separate page)

2.2 Transition Zone of the LPF

The difference between the stopband edge and the passband edge is called the transition width of the filter:
� O! D O!s � O!p. The smaller the transition width, the better the filter because it is closer to the ideal filter
which has a transition width of zero.

(a) For the two lowpass filters from Section 2.1, determine the transition width.

(b) Comment: “when comparing two M th order filters, the one with a smaller transition width will have
larger ripples.”

(c) Design a new Hamming-window LPF that has the same cutoff frequency, O!c D 0:4� , but twice the
order, i.e., M D 60. Repeat the measurement of O!p, O!s and � O! for this LPF.

(d) Compare the values of � O! from parts (a) and (c); when the order doubles, describe what happens
to the transition width. Use this observation to explain that the following Hamming window design
formula should be true

� O! D
C

L

and find the value of the constant C .
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2.3 Design FIR Filter to Meet Given Specifications

Filter design for lowpass filters involves five parameters: two band edges, ripple heights in two bands, and
the filter order. There is a sixth factor, which is the type of filter such as a Hamming windowed FIR filter. A
typical design problem would be stated as follows: given the band edges and ripple heights, determine the
minimum order filter that will meet the specs.

(a) Suppose that you are given O!p D 0:68� , O!s D 0:72� , ıp D 0:01, and ıs D 0:01. Make a sketch of an
ideal filter and a template that looks like Fig. 3. Label everything carefully and completely.

(b) Use your Hamming window design formula (from the previous section) to predict the filter length (L)
that will be needed to meet the specs. Recall that LDM C1.

(c) Design the Hamming-windowed FIR filter with the predicted order. Determine the correct value to use
for the cutoff frequency. Show the frequency response to your lab instructor for verification. Explain
why the resulting frequency response does or does not meet the given specs.

3 Lab HW: Filter Design via Optimization

Many different methods have been developed for filter design via mathematical optimization. One of the
widely used methods is firpm in MATLAB. For designing a LPF, it uses the following two step process:

1. Use the desired specifications for O!p, O!s , ıp, and ıs to estimate the filter order (M ) that will be
needed. This is done with the MATLAB function firpmord.

2. Use the outputs from firpmord as inputs to the function firpm to run the optimization and obtain
the FIR filter coefficients that should meet the specs on ıp and ıs . In effect, the inputs to firpm are
O!p, O!s , M , and the ratio ıp=ıs .

For the calling arguments of these functions, do help firpmord and help firpm.

(a) Suppose that you are given O!p D 0:68� , O!s D 0:72� , ıp D 0:05, and ıs D 0:01. Notice that the specs
on ıp and ıs can be different, unlike the window method that always has ıp D ıs .
Carry out the two design steps above to get the filter order M and the filter coefficients fbkg.

(b) Make a plot of the impulse response of the filter. Recall that the filter coefficients of the FIR filter are
the values of the impulse response. Also, the DTFT of the impulse response is the frequency response
of the FIR filter.

(c) Make a plot of the frequency response magnitude versus O!. Then check whether or not the ripple
specs .ıp; ıs/ have been met. The band edges should definitely be correct because O!p and O!s are
inputs to firpm.

(d) If the ripple specs are not met with the predicted order, then increase the order by one and try again.
A higher order such as M C1 or M C2 should meet the specs.

(e) The phase of this FIR filter will be linear phase. Determine the slope of the linear phase.
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Lab: FIR Filter Design GUI
INSTRUCTOR VERIFICATION SHEET

Turn this page in to your lab grading TA before the end of your scheduled Lab time.

Name: LoginUserName: Date:

Part Observations

2.1(a,b) Passband and stopband edges of FIR filter designed with rectangular window. Measured values:

2.1(c,d) Passband and stopband edges of FIR filter designed with Hamming window. Measured values:

Verified: Date/Time:

2.2(a) Transition widths of FIR filters designed with rectangular window and Hamming window.

2.2(c) Passband and stopband edges, and transition width, of longer FIR filter designed with Hamming window. Measured values:

2.2(d) Dependence of transition width on filter order for FIR filter designed with Hamming window. Find C in � O! DC=L.

Verified: Date/Time:

2.3(a) Make a sketch of ideal filter including a tolerance template like Fig. 3. Draw the sketch on the axes below.

2.3(b) Predict length of the FIR filter to be designed with the Hamming window, using � O! DC=L. LD ?

2.3(c) Give value of O!co, and show frequency response of filter to lab TA. Zoom in on passband stopband regions to verify.

Verified: Date/Time:

6
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Lab: FIR Filter Design GUI
LAB HOMEWORK QUESTION

Turn this page in to your lab grading TA at the very beginning of your next scheduled Lab time.

Name: LoginUserName: Date:

Part 3 Design an FIR filter via optimization with firpm.

(a) The specs are O!p D 0:68� , O!s D 0:72� , ıp D 0:05, and ıs D 0:01.
Carry out the two design steps to get the predicted filter order M and the filter coefficients fbkg.

Note: If you had to increase the filter order to meet the the ripple specs .ıp; ıs/, then show the impulse
response and frequency response magnitude of that FIR filter, and give the value of M that was used,
as well as the predicted value of M .

(b) Hand in a plot of the impulse response of the FIR filter.

(c,d) Hand in plot(s) of the frequency response magnitude versus O!. Verify that all the specs have been
met; showing zoomed plots of the passband and stopband regions would be the best way to verify.

(e) The phase of this FIR filter will be linear phase. Determine the slope of the linear phase.
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